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The Joy of Tournaments User Guide for NSDA District Tournament Set-Up [BEFORE] 

Things to do BEFORE an NSDA District Tournament 

The following notes will help you have a successful first-time experience with the Joy of Tournaments. 
The instructions that follow are far from exhaustive descriptions of each process. The Help option in 
the software provides you access to well over 500 pages of documentation. The following notes are 
geared specifically toward an NSDA District tournament whereas the help pages inside the software 

contain a lot of information that may only apply to other tournament styles.  

NOTE: This document is part 1 of a 3 part series for NSDA District tournaments.   
Part 2 covers tasks DURING the tournament and part 3 covers tasks AFTER the tournament. 

Use this as a checklist for things to do BEFORE the tournament: 

_____ 1. Download/Install/Authorize.   
_____ 2. Save your tournament.   
_____ 3. Configure the initial setup. 
_____ 4. Import website registrations. 
_____ 5. Assign codes.   
_____ 6. Create and copy the schedule.   
_____ 7. Add your rooms to the software / assign rooms to events. 
_____ 8. Set up NSDA rules and options.   
_____ 9. Create schematics for IE / Pair debate rounds. 
_____ 10. If needed, assign judges.   
_____ 11. If needed, add a judge, enter a school, or add a new entry. 
 

BEFORE the tournament: 

 
1. Download/Install/Authorize.   

A. Download the software on to your computer/update to the latest version.  
Log in to your website and click on the red Administration link and then on Software 
Download.  Click on Full Version. (NOTE:  If this link does not appear, email a request to 
add the software to your order to: support@joyoftournaments.com.) 
  
NOTE:   You may safely download the software multiple times if necessary for your 
tournament. The installation process will not harm your data if you have already begun 
preparation for your tournament. The installation process only updates the PROGRAM 
leaving your data untouched. 

If you download the software more than 1 week prior to your tournament, it is highly 
recommended that you repeat the process the week of your tournament to make sure that you are 
running the most recent set of updates for your tournament.  

Before the Tournament Process 
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 When you click on this link you’ll see the program downloading into the “downloads” folder.  
Depending on your browser will depend on where you’ll find it, but you need to open your 
download list and click on the Installjoy.exe file.  If you see a File Download – Security 
Warning dialog. Select the button labeled Run.  

 

 The Setup process will start with a screen that says, “Welcome to The Joy of Tournaments 
Setup Wizard”.  This will give you the version number it’s trying to install and a 
recommendation to close all other applications before continuing.  Click Next, and follow the 
prompt for installing.   
 

 When the last box appears, be sure to click Launch The Joy of Tournaments and then click 
Finish. The Joy of Tournaments should automatically open to the registration box.  If not, click 
on the Start Menu and open The Joy of Tournaments.  (Follow the steps below to license the 
software.) 

B. License the Software Using the Registration Wizard. 
 

The next step will be to enter an "authorization key". The presence of an authorization key will 
convert the "trial" version of the software into the full version of the software. Without an 
authorization key, the software will not allow you access to particular options nor will the program 
allow you to print.  

 
NOTE:  If you have recently run a tournament, you’ll still need to get a CURRENT key; 
otherwise, you risk being returned to “trial” mode when the older key expires. 

 The software should open and you should see the registration box with the Machine ID already 
in the Machine ID box.  NOTE:  If you have a current license, you may see the Events page 
instead.  To open the registration box, click on Help and then on Registration.  Click the 
Registration Wizard. 
 

 When the next box appears, enter the email and password you use for logging into your Joy of 
Tournaments website.  Leave the bottom two boxes blank and click Get Key.   
 

 You should be directed back to the registration box.  The serial number and key will 
automatically be placed in the appropriate boxes.  Click OK.  You will get a box that says, 
Registration Succeeded.  Click OK and that computer is officially licensed for your 
tournament. 
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2. Save your tournament.  
 

A. Go to the File menu and select 
Save As. 
 
NOTE:  You should select a 
location on your computer to 
save the data for your 
tournament. It is recommended 
that you do not save on a 
network drive. It is also 
recommended that you do not 
save on a thumb drive. If at all 
possible, it is recommended that 
you save your work on the local 
hard drive of the computer you 
will be using for tabulation. It is 
also recommended that you 
create a separate folder on your computer to store the data. If you will press the Create New 

Folder icon ( ), you can easily create a new folder. Rename the "new folder" to something 
appropriate (e.g. "JOT NSDA DATA", or "NSDA Data" – or whatever name you need).   
 

NOTE:  You must REPLACE the 
"*.trn" that will initially appear in 
the "File Name" field with a file 
name representing your 
tournament (e.g. Anywhere 
NSDA District Debate).  

  

B. To test that this step has been 
completed successfully, EXIT the 
application (select File -> Exit 
from the menu). When you exit the 
application, you should not see 
any questions or prompts appear. 
If you do get a prompt of any kind 
on exit, one of the steps above 
has not been completed 
successfully.  
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If the program exits without any messages, you should then open it back up. The title bar of 
the application should have the name of your tournament that you supplied earlier in this 
process. If you see "Untitled Tournament" in the title bar, your data is not being saved properly. 

IMPORTANT NOTE: From this point forward, you should never see a red flashing "save" 
message in the status bar of the application. If you see this message at any time, you should 
immediately STOP what you are doing and save your work. Any time the flashing red "save" 
message appears, your data is not being saved. 

3.  Configure the initial setup. 

The next step is to complete the "initial 
setup" of the software. The steps listed 
here are the most important steps you will 
perform. Click on File -> Properties.  You 
will see a screen similar to the following: 

A. Starting in the General tab, enter the 
title of your tournament in the Name 
box as you want it to appear on 
reports and postings.   

 Select the correct Start Date and End 
Date – NOTE:  Be sure these dates 
match the dates on your website 
and DO NOT SKIP THIS STEP. 

 The rest of the defaults will be correct 
for all of the other options on the 
General tab.  
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B. Click on the Host Info tab.  You 
will see a screen similar to this 
one:  

 In the School field enter the 
location of the district 
tournament. 

 In the NFL District box at the 
bottom, enter the name of your 
NSDA District (e.g. "Tall Cotton", 
"Lone Star”).  

 

 

 

 

 

C. Next, click on the Styles tab. You 
will see a screen similar to the 
following one. 

 Select NFL District Tournament.  

 If have special permission from 
NSDA to use this option, select 
Accelerated Elimination. 

 Select California plan if you plan 
to use this method of tabulation.    

 If your district has earned the 
option of having bonus 
qualifications, select Bonus 
Qualifications. In the box next to 
it, indicate how many qualifiers.  
NOTE:  Enter the TOTAL number 
of slots – not the ‘extra’ slots) your 
district has earned.   

 Press OK.  
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4. Import events and website registrations.  

The website import will give you a head start on some of the following steps, so if you are doing 
this setup work in advance of your tournament, you may repeat the import process again closer to 
your actual tournament.  Prior work on rooms and rounds will not be lost when importing data. 

A. OPTION A:  QUICK IMPORT 
- Click on File->Import 
Website Entries->Enter your 
email address and password. 
 

 A dialog box will appear that is 
labeled, Web Import -> 
Locate Data Files. The 
default option, Download 
directly from 
joyoftournaments.com has 
already been selected. Type in 
your email address and your 
password. Click Next. A dialog 
box will appear indicating the 
download is in progress.  
 
 

 The next box that will 
appear is the Web Import 
-->Map Events box.  
 

 If there are no items in 
the Unmapped Web 
Events box, click Next. 

NOTE: If there are any 
events in the 
“Unmapped” box, you 
will need to tell the 
computer how to match 
them. The items on the 
left in the Mapping box 
are the ones that have 
been created inside the 
tab software.   The events in the middle of the Mapping box are the ones that are available on 
the website.  The events need to match in order to import correctly.   
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NOTE: An event will be unmatched if the names inside the tab software and on the website 
don’t match exactly.  For example, the website may have “International Extemp” while you 
have created an event named “Foreign Extemp”.  The “mapping” process helps the software 
know that these two events are actually the “same”.  

 To clear the Unmapped 
Web Events box, double-
click on one of the items in 
the Unmapped box on the 
right.  

 

 

 

 

 

 
 

 Another box will appear with a list of 
potential events that match.  Click on 
the item that matches.  If there are no 
other names that are similar and you 
need to create a new one, then click 
on "new event".  Click OK. Repeat this 
process for each of the items that 
need to be mapped.  

 
 

 
 
 

 
 

 



 

 

Page 8 of 42 Before the Tournament Guide Revision: Spring 2014 

 

The Joy of Tournaments User Guide for NSDA District Tournament Set-Up [BEFORE] 

 Once the items are mapped, 
the “Unmapped” box will be 
empty.  Click Next.  

 

 Repeat the above process as 
needed for any unmapped 
schools.  
 

 When the mapping process 
has been completed, The 
Web ImportImport Entries 
box will appear. Click on 
Begin Import. When the 
download is complete another 
box will appear to indicate that 
the import is complete.  Click 
Finish.  

 
B. OPTION B:  TWO-STEP PROCESS 
 
Step 1: Importing the website entries from the website to a saved location on your computer.  
Log into your website on http://www.joyoftournaments.com, and click on Administration. On the left 
under the control panel, click on Export Data. Then, click on the option that says, Export Entries 
(Joy of Tournaments Import Format). 

 A page will appear that is titled, Export 
Website Entries. Right click on the 
blue link that says, Web Download 
Definition (tourn.txt) and select, Click 
on Save Target As.  (Different 
browsers may show different options, 
i.e., FireFox users will see Save Link 
As. Select the option that allows you to 
save the file in a location on your 
computer. 
 

 

 

 

 

http://www.joyoftournaments.com/
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 Once you select Save As, and select a location on to save the data.    NOTE:  As a default 
setting, the computer will save the name of the file as “tourn.txt”.  It is strongly 
recommended that you do not change the name of the file.  Click Save.  
 

Step 2: Importing the website entries from a saved location into the tabulation software.  Get 
out of the browser, return to your desktop and open The Joy of Tournaments software program on 
your computer. Click on File and then Import Website Entries. 

 A dialog box will appear that is 
labeled, Web Import -> Locate 
Data Files. Select the second 
option that says, Load from disk 
(data has been downloaded 
separately from the website 
and stored on disk). Then, click 
Browse. 

  

 

 
 
 

 When the Open dialog box appears, find 
the file where you saved your 
tournament data in the step above in 
Part 1. You are looking for a "tourn" file 
with the (txt extension). Click on Open.  

Note:  You may need to change the 
file type to “Text Files (*.txt). To do 
this click on the dropdown arrow in 
the box, “Files of Type” and select the 
text files option. 

 The Web Import – Locate Data Files 
box will reappear.  Verify that the address/location is correct in the browse field and click Next. 

NOTE:  Follow the remaining mapping and import process as directed above in Option A. 
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NOTE:  Sometimes, school servers or security firewalls prevent information from coming in from 
the internet and may prevent your import.  For further assistance and alternatives to this process, 
visit http://www.joyoftournaments.com/help/webimport.htm for detailed instructions. 

NOTE: By completing the above process you have imported the events and registrations for your 
NSDA District Tournament.  If you’re not using the website for registration and need help setting up 
the events, you’ll find instructions in this document -> Tab Software Training Notes. 

5. Assign Codes    
 
You will need to assign codes to schools AND students for your NSDA tournament (especially if 
you’ll use the Up/Down Method).  NOTE:  Each school should be assigned a letter code.  

A. Assign School Codes - There are two methods for assigning school codes. 

OPTION A: You may have the software assign 
codes to the schools by right-clicking on the 
Schools folder on the left-hand navigation tree and 
select the Assign School Codes option. When the 
dialogue box appears, choose one of the “Letters” 
options. 
 
 

 

OPTION B:  If you already assigned codes 
to the schools as you have received the 
entries, you can hand-enter each school 
code. Select the Schools folder on the 
navigation tree, right-click and select 
Properties. The edit school dialog will 
appear and you’ll enter the letter in the 
Code box. 

 

 

    

 

http://www.joyoftournaments.com/help/webimport.htm
http://www.joyoftournaments.com/help/JOT%20Training%20revision%20date%20Aug%202010.pdf
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B. Assign Student Codes - Once 
you have the appropriate codes 
assigned to each school, you 
may then assign codes to each 
individual competitor. Click File 
 Assign Codes. The Assign 
Contestant Codes box will 
appear.  

You may select any of the options 
that best works for your district 
tournament.  You may wish to select 
one of the two "NFL" options.  
 
NOTE about the NFL options:  If 
you select the NFL (xe uses unique 
code), a cross-entered student will 
have a unique code for each event 
in which they are entered. If you use the NFL (xe uses 1 code) option, a cross-entered student 
will have the same code for both events.   

To view the how the codes appear for each student, select a specific school under the Schools 
folder.  You will see the students from that school appear along with their code in the right-hand 
pane.  

6.  Create and copy the schedule.   

Up/Down Method NOTE:  You probably won’t know your full schedule ahead of time, but you 
should have at least a good idea of how the first two or three rounds of every event will run.  You 
can always change the schedule "on the fly", but it is recommended that you at least setup the 
first two rounds up front. 

 
California Plan NOTE:  It is recommended that you set up all your rounds in the beginning since 
the NSDA Manual outlines your schedule based on entries.   

NOTE: The process of setting up the rounds "on the fly" is the same as it is to do it ahead of time. 
If you'll set up a few rounds early, you'll at least be more familiar with the process.  
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A. Create the schedule.  On the 
navigation tree on the left, select the 
event and right-click on it. Click on 
Rounds. When the box appears for 
that event, double-click on the rounds 

to add them to the bottom Schedule 
box.   

 

 

 

 

 

 

 
 
 
 
 

 Double-click on the round at the 
bottom to set the time and select the 
options for your tournament.  You will 
see a dialog similar to this one.  Click 
OK. 
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NOTES TO CONSIDER:    

 This is where you will set the flighting and panels for each round. Repeat this process for 
each round that you are ready to schedule for the event. 

 This dialog changes in appearance slightly based on some of the characteristics that you have 
selected about the event you are working with. For example, if you select Round 1 of a debate 
event, the option to flip for sides will not be grayed out.  

 The program compares actual dates and times internally to determine if two rounds occur at 
the same time. 

 To edit a round again, select the event and click the Edit button. 
 

 When you click on the 
event on the left, you 
will see the summary 
page on the right.  
Review the schedule 
to be sure it is properly 
displayed. Make sure 
that the DAY of each 
round is correct. Make 
sure that the times are 
listed correctly. If you 
have any problems 
with the schedule, you 
may return to the 
Rounds dialog again 
to edit the dates and 
times until the 
summary page 
appears correctly.  
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B. Copy the Schedule/Rounds to Other 
Events - Since it is common that several 
events will run with a common schedule, you 
may copy the schedule from one event to 
another. Right-click on the event and select 
Copy Rounds.  

 Select the events that have the same 
schedule from the list of events that appear 
and then press OK to copy the schedule.   

 

 

 

  

 
 

7. Add your rooms to the software / assign rooms to events 

A. Add rooms. To enter the 
inventory of available rooms, 
right-click on Rooms on the left-
hand side.  You will see the Edit 
Room box appear. 

 NOTE: You will only *need* to 
enter the room number in the 
Name box and then hit Enter.   
By default, the rooms are 
ALWAYS AVAILABLE.  Enter 
times ONLY if the room has a 
special schedule.   

 The only field that is required on 
this screen is the name of the 
room. The name of the room 
should be listed the way you 
want the room to appear on postings when this room is assigned. Examples: Room 10, ZACH 
304, JH 102. The names should be relatively short (12 - 15 characters) although you may use 
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anything you want. If you use longer names for the rooms, there are some reports which will 
not be able to display the full room name.  
 

 As you enter the rooms 
that are available, the 
"Room Usage" report will 
be updated to reflect 
each room you have 
entered.  

 Continue entering rooms 
until you have your room 
list entered. If you leave a 
room off, you may always 
come back later and add 
it, but entering the room 
inventory early is a good 
idea.  
 

 Should you need to make 
a correction to a room 
(correct spelling, change 
the times the room is 
available, add notes, etc.), you may do so by moving your mouse over the name of the room in 
the right-hand window (where the Room Usage report appears). As you move your mouse 
over the name of the room, the room name will turn blue. When the room turns blue, right-click 
and select Properties from the menu.  

B. Assign rooms to events.  After you have completed the room inventory list, you may begin 
assigning rooms to specific rounds and events. To do this, go to the events folder on the 
navigation tree and find an appropriate event. Right-click and select the option labeled Rooms.  
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 A dialog box for the event will appear.  
At the top of the dialog next to the 
Round is a drop-down list of the 
rounds you have scheduled for the 
event. Select the appropriate round 
from the list.  
 

 A list of the rooms that are available 
during the time frame you have 
indicated for the specific round of the 
event will appear on the left-hand side 
of the dialog (under the heading of 
Rooms. A room is available if no other 
event is scheduled to use the room at 
the time specified for this round and 
the room has not be indicated as 
unavailable at that time.  
 

 NOTE: At the bottom of the dialog 
there are two radio buttons. One is 
labeled All and the other is labeled Available. Initially, the radio button labeled Available will 
be selected. When the Available option is selected, the left-hand list will only contain the 
rooms which are not in use at the same time as the round you have selected at the top of the 
dialog. If you select the All option, the left-hand list will show all rooms from the inventory of 
rooms regardless of availability. It should only occasionally be necessary to switch over to the 
All option. 
 

 The rooms that appear on the left-hand side are color coded to provide you with additional 
information about the rooms. The color code is as follows:  

 

 

 

 
 

 

 

 

Background Color Meaning 

White Room is available for use 

Black 
Room has not been indicated as appropriate for this specific round 
although it isn't in use 

Red Room has been marked as Unavailable 

Gray 
Room is in use by another event at the time this round is 
scheduled 
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 The right-hand side of the dialog will 
display each of the rooms that you have 
selected for use during the selected 
round. To move a room from the list on 
the left-hand side of available rooms to 
the right-hand side of selected rooms, 
there are two options:  

 Select the room on the left with 
the mouse. When the room has 
been highlighted, press the >> 
button in the center of the dialog. 
Multiple rooms may be moved 
together using this method.  

 Double-click on a room in the 
left-hand list of rooms.  

NOTE: To remove a room that has been 
selected for use (in the right-hand list of 
rooms), simply reverse the process 
(double-click on the unwanted room or 
click on it and click the << button. 

 Repeat this process for each round of the event until all needed rooms appear in the Selected 
Rooms list on the right. 

 If you wish to double-check the room assignments for an event, you can easily return to this 
view by right-clicking on the Round then click on Rooms.   
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C. Understanding the 
Room Usage page -  A 
“grayed out” bar 
indicates the room is 
being used. You can 
quickly see which rooms 
are in use and which 
rooms are still available 
during different periods 
of time. If a room has 
been over-scheduled 
during one of the time 
periods it is in use, the 
bar representing that 
time period will be red. 
The bar for a room will 
also appear in red if the 
room has been marked 
as Don’t Use. If a black 
bar appears, it 
represents an ‘extra’ 
room that is available at 
that time, but has been 
assigned to a particular event.  

 

 You can view the 
assignments for a 
specific room by pausing 
over the room's name 
with the mouse. When 
you hover over the room, 
a tip will appear listing 
each of the assignments 
for the room.  This 
example shows the 
assignments for Room 1 
where a red bar is 
indicating a conflict.  This 
example shows a conflict 
with room 1.  When 
viewing the assignments 
you will see that at noon 
a round of HI has been 
inadvertently assigned to 



 

 

Page 19 of 42 Before the Tournament Guide Revision: Spring 2014 

 

The Joy of Tournaments User Guide for NSDA District Tournament Set-Up [BEFORE] 

the same room at the same time the IX round is scheduled there. 

 To easily substitute or 
reassign this room, right-
click on the Room (on the 
right-hand side) and click 
on Assignments. 

 

 

 

 
 
 

 

 When the Room Assignments box 
appears, click on the event you wish to 
reassign.  The options on the right will 
become active.  Select Substitute.   

NOTE: If you wish to remove or move all 
assigned rooms, you may select those options 
as well.  This example will show how to 
substitute a room. 

 When the Room Substitution box 
appears, select the appropriate room and 
select OK.  The Room Assignments box 
will reappear.  Verify that the event disappeared and click OK again. 

 On the Room Usage page, the red bar will have disappeared. 

 

 

 

 



 

 

Page 20 of 42 Before the Tournament Guide Revision: Spring 2014 

 

The Joy of Tournaments User Guide for NSDA District Tournament Set-Up [BEFORE] 

 

NOTE:  You may also filter 
this Room Usage page to 
view only certain days of 
your tournament.  For 
example, if you are running 
a two-day (Friday & 
Saturday) tournament and 
you only want to view the 
Saturday Rooms, you may 
do so.  Click on the drop-
down arrow at the top of 
the page (just to the left of 
the “Time” option).  The 
dates of your tournament 
will appear.  Select the date 
you wish to view and the Room Usage view on the right-hand side will change to reflect your 
requested date. 

 Another option for 
viewing room 
assignments is to use 
the room Grid. To view 
this grid, open up the 
rooms folder and click on 
Grid.  

NOTE:  This feature may 
also be filtered to view only 
certain days of your 
tournament.  For example, if 
you are running a two-day 
(Friday & Saturday) 
tournament and you only 
want to view the Saturday 
Rooms, you may do so.  
Click on the drop-down 
arrow at the top of the page 
(just to the right of the “J”, 
“E” and yellow “?” buttons 
and to the left of the “Time” option).  The dates of your tournament will appear.  Select the date 
you wish to view and the Room Usage view on the right-hand side will change to reflect your 
requested date. 



 

 

Page 21 of 42 Before the Tournament Guide Revision: Spring 2014 

 

The Joy of Tournaments User Guide for NSDA District Tournament Set-Up [BEFORE] 

 

8. Set up NSDA rules and options.   

In order for the events to tabulate 

according to NSDA rules, you will need to 

select the necessary options for each 

event. To do this right-click on the event 

and select Properties and then Misc.)  

NOTE:  Repeat these options for each 

event.)  

 

A. Set the tabulation method.  From the 

dropdown menu next to Tabulation 

Method, select NFL.  NOTE:  You 

should IGNORE the "Prelim Ranking 

Rules". 

 

B. Choose the ballot style. 

 

 For each IE event, there is a specific 

NSDA ballot.  Next to Ballot Style, 

select the appropriate NFL ballot.  

 Print IE ballot.  Open the Event folder on the left and then right-click on the round folder.  

Then select Print All Ballots. 

 For Public Forum select Debate – Team Points from the dropdown menu. 

 For Lincoln-Douglas and CX Debate select Default from the drop down menu. 
Print Debate ballots: Open the Event folder on the left and then right-click on the round 
folder.  Then select Debate Ballots. You may add notes (e.g., the topic) in the Message box. 

 You should IGNORE the Single Performance and Entire Round "duration" fields. The 
defaults (indicated by a zero) are sufficient. You can safely IGNORE the minimum and 
maximum speaker points because for NSDA districts all that is necessary is a win/loss record 
in debate.  

 You should IGNORE the speaker goal because the speakers per section is outlined by the 
district tournament manual and the software knows about the chart. DO NOT check the "All 
ballots form virtual panel for finals" option.  Click OK.  
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C. Set miscellaneous options.  

 Next, you will click on the Options tab.  
Depending on the event will depend on 
what options are not “grayed out” and 
are available for use.  For Dramatic 
Interpretation, Humorous Interpretation 
and Duo Interpretation you will need to 
select the Track Selections option. 

 

 

 

 

 

 

 For Public Forum, you will need to select 
the “Label Aff/Neg as Pro/Con (Public 
Forum)” and “All rounds flip (Public 
Forum)” options. 
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9. Create schematics for IE / debate rounds. 

Up/Down Method NOTE:  The first two rounds will be automatically created since they are 
already pre-set. 

 
California Plan NOTE: For the California Plan, the first round is pre-set.  Because the second 
round is powered off the first round, the second round will be created after all ballots have been 
entered. 

 

A. Create Sectioning for Individual Events or Debate - To create sectioning or pair an event, 
right-click on the specific round of the event.   
 
For IE, choose Create Sectioning:   For Debate, choose Pair: 
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 For IE, a dialog similar to the following 
should appear.  If needed, modify the 
numbers to reflect the number of 
sections you wish to have, and click 
OK. 

 

 

 

   

 
 
 
 
  
  
 
 
 

 When creating a debate paring a dialog similar to the following should appear. Select Yes to 
create the debate pairings.   
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 For IE, a schematic similar to this one will appear: 

 

 

 

 

 

NOTE:  You may edit your schematic on the left by dragging and dropping the students to 

different rooms/sections. 
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 For debate, the pairing will appear on the right side of the computer screen and look 
something like this. 

 

NOTE:  You may edit your schematic on the left by dragging and dropping the students to 

different rooms/sections. 
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10.  If needed, assign judges - There are two ways to assign judges.  You may automatically assign 
judges or you may manually assign judges.   

NOTE: The website will only allow for entry of “school-affiliated” judges.  If you didn’t use the website, 
or if you need to add hired or volunteer judges to the tournament you may do so.  (See the 
Addendum section at the end of this document for details.) 

A. Automatically Assign Judges - To automatically assign judges, double-click on the event to 
display each of the rounds of the event on the tree.  Right click on a Round and a dropdown 
menu will appear. Select Auto Judge Assignments. 
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 When the Assign Judges 
dialog appears, click OK.   You 
may wish to change some of the 
options as displayed on this 
dialog to modify the judges that 
are considered in the 
assignment process.  The 
Assign Judges dialog box will 
something like this one: 

 The schematic will appear on 
the right and will now display 
the assigned judge names.     

 NOTE:  This does not 
automatically assign judges to 
all events and rounds 
simultaneously.  Repeat this 
process for each round of each 
event.   
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B. Manually Assign Judges for DEBATE – There are two ways to manually assign judges:  Via 
the navigation tree or via the schematic. 

 Via the navigation tree - 
Right click on the Round 
and click on Manual 
Judge Assignments. 

 When the Manual Judge 
Assignment dialog 
appears, you may make 
changes to that round.  
(See instructions in the 
next section.) 

 

 

 

 

 

 

 Via the Pairing (Debate) 
Find the room/section on 
the pairings of the event 
you want to assign 
judges.  Right click on one 
of the student names.  
When the dropdown 
menu appears, click on 
Manual Assign Judges. 

 

 

 

 

 

 Via the 
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Schematic (IE)   Right click on one of the room numbers or over one of the sudent codes.  
When the dropdown menu appears, click on Manual Assign Judges. 

 

 

 When the Manual Judge Assignment dialog appears, you may make changes to that round.   

 Note what section 
of this round you 
are editing and 
change sections, 
if needed.  If you 
come in via the 
pairing or room, 
you’ll start with 
the section you 
right-clicked on; 
otherwise, the 
default setting is  
start with section 
one. 

 

 

 

 

 

  

 Note the 
competitors to 
whom you wish to 
assign a judge.  If 
you click on one 
of the 
competitors, you 
will see the 
details of that 
competitor in the 
box on the right. 



 

 

Page 31 of 42 Before the Tournament Guide Revision: Spring 2014 

 

The Joy of Tournaments User Guide for NSDA District Tournament Set-Up [BEFORE] 

 

 

 

 

 

 

 Choose a judge 
from the 
Possible 
Judges box. 
When you click 
on a particular 
judge you will 
see the details 
for that judge in 
the box on the 
right. 

 

 

 

 

 
 

 If this is the judge 
that you wish to 
choose, double-click 
on the judge name.  
The selected judge 
will appear in the 
box labeled, 
Assigned Judges.  
Click OK.  
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NOTE:  This dialog offers other options.  See the diagram below for further descriptions. 

 

 

 

 

 11.  Addendum - If needed, add a judge, enter a school, or add a new entry. 

A. Add Judges - NOTE: You may only need this option if you are entering non-school affiliated 

judges (hired or volunteer); otherwise, you can skip this step if you have imported the entries 

from the website. 

 The website will only allow for entry of “school-affiliated” judges.  Judges not affiliated with a 

school will need to be hand-entered.   If you didn’t use the website or if you need to add hired 

or volunteer judges to the tournament you may do so by right-clicking on the Judges folder on 

the navigation tree on the left and select Add.  

 The Edit Judge box will appear.  While this dialog has numerous options, the only field that is 
required is the judge's name. All of the other fields reflect additional information that you may 
use to assist you in the process of contacting, recording, and assigning judges.  
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 Each of the fields on this dialog is described in the following table.  

Field Description 

Name The name of the judge. This is the only required field for defining a judge. 
Each judge must have a unique name. This name will be displayed on 
ballots and postings where judge information is provided. Typically you 
will want to provide full names, as in John Brown, and Julie Smith, but 
you may use whatever names you desire (for example, last name only).  

Code The judge code. Options exist in various places to display a judge code 
instead of the judge name. If you want to use those features, you must 
provide a code for each judge. The code can be anything you want it to 
be. It is recommended that you use a short code (3-4 characters).  

School This field allows you to record a school affiliation for the judge. By 
recording the affiliation, you are automatically recording a judge 
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Field Description 

restriction; they will not be scheduled to judge competitors from the 
affiliated school. Additional restrictions may be coded for the judge. The 
affiliation field is used to record the primary affiliation. If you are requiring 
that judges be provided by each school, use this field to record the 
school that receives the credit for providing the judge.  

Region Use this field to indicate the region the judge represents. If you are 
attempting to balance judges by region, the software will use this field.  

District Use this field to indicate the district that the judge represents. If you are 
attempting to balance judges by district, the software will use this field.  

Note This field provides a customized note for each judge. The note will 
appear on assignment sheets given to the judge. You may provide 
personalization to your assignments using this field. Examples: Hey Joe, 
stop by the tab room – I have a trophy for you from last week’s 
tournament, or Thanks for judging Mary.  

Phone Primary phone number to use to reach the judge.  

Work 
Phone 

Work phone number of the judge.  

Cell 
Phone 

Cell phone number of the judge.  

Pager Judge's pager number.  

Email Use this field to record an email address that may be used to reach the 
judge.  

Events The events this individual may actually judge. Initially, the Any Event 
check box will be checked indicating that the judge may be scheduled in 
any event. If so, the list of events will be disabled. If Any Event is 
unchecked, then the events highlighted in this list represent the events 
for which the judge may be scheduled.  

Any Event If checked, indicates that the judge may be assigned to any event for 
judging. 

Date / 
From / To 

Use these three fields to indicate when a judge has indicated they will be 
available. You may then press the button labeled Add >> to move the 
availability into the list of times the judge is available (labeled 
Availabilities). You may remove an availability by highlighting the time in 
the list and pressing the button labeled Remove.  

Unavailable Use this checkbox to indicate that a judge is not available for any judging 
slots.  

# Rounds Maximum number of rounds for which the judge should be scheduled. 
This box will be disabled if the As Needed box is checked. The 
application will honor this limit when instructed to do so. You may over-
ride the limit by making assignments manually or requesting that the 
limits be ignored when automatically assigning judges.  

As 
Needed 

Indicates that the judge may be used for as many rounds as needed. In 
other words, this indicates that there is no maximum number of rounds 



 

 

Page 35 of 42 Before the Tournament Guide Revision: Spring 2014 

 

The Joy of Tournaments User Guide for NSDA District Tournament Set-Up [BEFORE] 

Field Description 

allowed for the judge. 

Normal / 
Light / 
Medium / 
Heavy 

If you have indicated that the judge be used As Needed, this field 
provides an additional level of priority for using the judge. Light indicates 
that the judge should be used as few times as possible; Heavy means as 
many times as possible. Medium indicates the judge should be used 
slightly more than Normal, but not excessively. Normal is the default.  

Obligation Use this field to record the number of rounds the judge is obligated to 
judge.  

Base 
Priority 

Judges are assigned based on a priority system. Judges normally start 
out with a priority of zero. If you want to favor this judge for assignments 
(that is, place them in more rounds), assign a base priority for the judge 
greater than zero. The priority scale by default runs from zero to 
approximately 100. Higher numbers result in more assignments; lower 
numbers result in fewer assignments. You may also assign a negative 
number to reduce the likelihood of assignments for the judge. The actual 
judge that is assigned to each slot is based on a number of things. When 
all other considerations are equal, the software assigns the slot to the 
judge with the highest priority.  

Rating Use this field to rate the judge. Ratings are based on a scale from A to E. 
A represents the best rating.  

Private 
Note 

Use this field to keep a private note. This note will only appear on this 
dialog. You may keep notes here that you would not necessarily want the 
individual to see. For example, Avoid interp events, Argumentative. 
Caution is advised not to over use this field. 

Confirmed This field may be used to track judge confirmations. After receiving a 
confirmation for the judge, check this box. If you choose, confirmed 
judges may receive a different priority for judge assignments than 
unconfirmed judges.  

Checked 
In 

You may use this field to track which judges have Checked In or that you 
know are present at the tournament. When assigning judges, this can be 
used to alter priority for assignments.  

No Show This field may be used to indicate that the judge is a No Show.  

Hired Use this field to indicate that a judge is hired. Extra options exist within 
the software for hired judges to assist in payment.  

Don't Use When this field is checked, the software will mark the judge as being 
completely unavailable. The software will not assign judges with this 
attribute set. Additionally, you will be warned if you attempt to assign a 
judge that has been marked Don't Use. Use this field primarily to indicate 
that a judge previously thought available has become unavailable for 
use.  

Coach This field allows you to mark the judges that are coaches. You may use 
this field to alter the priority of assigning coaches as judges.  

Prelims If checked, indicates that the judge may be used in Preliminary rounds. If 
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Field Description 

unchecked, the judge will not be assigned to preliminary rounds of 
competition.  

Elims If checked, indicates that the judge may be used in Elimination rounds. If 
unchecked, the judge will not be assigned to elimination rounds.  

Stop 
Using 

When this field is checked, the software will stop assigning the judge for 
additional rounds. Any existing assignments will be retained, but the 
software will not automatically add any assignments to the judge. 
Additionally, you will be warned if you attempt to assign the judge after 
marking them with the 'Stop Using' flag.  

 NOTE:  Additional flags may appear on the bottom of this dialog if you are using user-defined 
judge flags (these flags were set up in the initial website preparation process). User-defined 
flags will appear following the 'Stop Using' flag.  

 

 

 

 

 

 

 
 
 

 When you return to the 

judge page (click on 

Judges) to view the 

judge list, the 

hired/volunteer names 

will have a special 

code next to the name 

to indicate they are 

hired. 
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B. Add a school. Right-
click on the Schools 
folder and select the 
option labeled Add from 
the dropdown menu. 
Selecting this option will 
bring up the dialog that 
appears.  This dialog 
allows you to store the 
information about a 
school. 

 There are only two fields 
on this dialog that are 
required: Code and 
Name. The remaining 
fields are all optional.  
Use the chart below to 
determine the 
information that you may 
enter in the different 
fields.  
 

 Using this dialog, you may enter the appropriate information for each school. Be sure to press 
the button labeled Enter. This will store the information you have entered for the current school 
and clear the dialog for entry of the next school. When you have finished with the dialog, press 
the button labeled Close. 

Field Description 

Code A short code that will be displayed to represent the school on all reports. It can be 
numeric, alphabetic, or anything else you want; however, the code you choose 
should be short – typically 1 or 2 characters.   For NSDA districts, school codes are 
typically alphabetic. 

Name The actual name of the school or squad. Typical values are Friona, Friona High 
School, Texas A&M University, Amarillo High Gold Squad, etc. This is a descriptive 
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Field Description 

name of the team. Result pages generally display the name of the school. 

Coach The name of the (primary) coach or sponsor for the school. 

Addr 1 First address line.  

Addr 2 Second address line.  

City City that the school represents. 

State State  

Zip Zip Code  

Phone Phone number of the school.  

Fax Fax number of the school.  

Home 
Phone 

Coach’s home phone number.  

Email Coach’s email address.  

Notes A text field that allows you to keep short notes about the school. This field does not 
appear on any reports.  

Has 
Arrived 

Used to mark a school as arrived. The arrival status may be tracked during 
registration allowing you to know which schools have/have not checked in.  

Squad 
Count 

Number of competitors from this school. This number is used in the calculation of 
squad efficiency. If you leave this number blank, the application will automatically 
calculate this number. If you supply a number here, the number you supply will 
over-ride the automatic calculation.  

Trophy 
Points 

This option is only available for NSDA District Style tournaments. Record the 
trophy points retained from previous district competition in this field.  

Additional 
Coaches 

A list of additional coaches for the school. Use the Add and Remove buttons to edit 
the names on this list.  

Affiliated 
Judges 

A list of judges that have been coded as affiliated with the school. Used primarily to 
determine if a school has provided sufficient judges.  

 

 

C. Add a new entry. There are multiple ways to enter competitors in the software. Here is the 
recommended process for manually typing in the entries.  
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 Go to one of the events on 
the navigation tree (it really 
doesn't matter which one 
you select). Open up the 
Events folder to reveal the 
"entries" folder beneath it. 
Right-click and select Edit 
from the context menu.  

 

 

 
 

 From the School 
dropdown menu, select the appropriate school from the list. (If the school is missing, you may 
use the "Add" button to add the school; see the previous section for information about adding a 
school.)  
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 From the Event dropdown 
menu, select the appropriate 
event from the list.  

 

 

 

 

 

 

 

 

 Type in the name of the 
contestant in the field labeled 
"Contestant Name".  
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 Press the Enter key on the 
keyboard (some keyboards label 
the key "return"). This will cause 
the student's name to appear in 
both the Squad Members box on 
the left-hand side and in the right-
hand box labeled "International 
Extemp entries" (or whatever 
event is selected).  

 

 

 

 

 
 
 

 Continue with this process to 
enter each of the students from 
the School/Event combination you 
have selected. You may change 
to a different event and/or a 
different school as you process 
additional entries.  

 The Squad Members list will 
include all of the students from 
the selected school that are 
entered in any event.  

 The Entries list in the bottom 
right-hand box will list just the 
students from that school that are 
entered in the selected event.  
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As a reminder, these instructions are not intended to be exhaustive of the entire software 
program.  They are meant to guide you through your NSDA District Tournament.  For a more 

specific explanation of these steps, refer to the manuals found on 
www.JoyofTournaments.com/help/ .  You may also sign up for one of our free training 

sessions at www.JoyofTournaments.com/training.asp. 
Our support staff is available via telephone Monday to Saturday to answer quick questions.   

The support number is 806-773-0162. 

http://www.joyoftournaments.com/help/
http://www.joyoftournaments.com/training.asp

